EndNote: Advanced

Danielle Westmark, MLIS
Leon S. McGoogan Health Sciences Library
Outline

1. Sharing libraries and groups
2. Editing citation styles
3. Tips & tricks on entering citations into EndNote
4. CWYW
   1. Unformatted citations
   2. Convert to Plain Text
5. Exporting citations from EndNote
Objectives

By the end of this session, participants will be able to:

1. Identify three methods to share citations with colleagues.
2. Create citations and citation styles.
3. Utilize two Cite While You Write advanced features in Word.
Sharing
Why Share Your Library?

• Collaborating on a project
  • Add citations, PDFs, notes
• Co-authoring a research paper
  • Add citations to the research paper
  • Make changes to the document, updates citation order
• Reviewing a paper (advisor, etc.)
  • Add citations to the research paper
  • Make changes to the document, updates citation order
Sharing Your EndNote Library

1. Create your EndNote Online Account
Sharing Your EndNote Library

2. Sign into your EndNote Online account on the desktop
   a. Go to Edit > Preferences (Windows); EndNote > Preferences (Mac)
   b. Enter your EndNote account information
   c. Click OK
   d. You can only sync 1 EndNote library per account! (does not include shared libraries)
Sharing Your EndNote Library

3. Share your entire library and provide Read & Write permissions
   1. File > Share…
   2. Enter email address (they MUST have an EndNote online account set up)
   3. Click Invite
   4. Invited members will receive an invitation and instructions on how to accept a request
Accepting a Shared Library

This Message Is From an External Sender
This message came from outside your organization.

Non-UNMC email

Teresa Hartman (jdhartm) would like to share an EndNote library with you.

Accept the invitation [account.endnote.com]

To accept this invitation and access Teresa Hartman's library, you must have EndNote X7.2 or later installed, and we strongly recommend using EndNote 20 for the best experience.
Accepting a Shared Library

To accept this invitation, sign in using the same credentials you use when accessing EndNote online or syncing your desktop library, or create a new account. To access this shared library you must have EndNote X7.2 or later installed.

1. EndNote Desktop > File > Open Shared Library
2. Select the shared library; a new window will open
3. If the shared library doesn’t appear, sync your EndNote account
Why Share an EndNote Group?

• If you use your library for multiple projects, you can share a specific group. Does not share the entire library.
• Collaborators can edit, add, and view citations
• Collaborators can add citations from a shared group to a Word document

Cannot view attached PDFs; only in shared libraries
Sharing EndNote Groups

1. Create an EndNote online account/Log in with existing account
2. Select the group you want to share and click the Share this Group icon
Sharing EndNote Groups

1. Enter the individuals email address and click invite

2. Set permissions

3. Invitees must have an EndNote Online account
Accepting a Shared Group

Cindy null has shared an EndNote group, shared project, with you.

To access this group, create or log into your EndNote online account at http://my.endnote.com [my.endnote.com].

Don’t have EndNote for your desktop yet? Get the latest version now to share whole libraries, create your own bibliographic styles, and more [endnote.com].

Learn more about sharing your research using EndNote [endnote.com].
1. When you have accepted a shared group request, go to EndNote Online to access.
Manage Your and Others Groups
Cite While You Write (Word)
Unformatted Citations

EndNote Library (Desktop) or Shared EndNote Library

1. In Word (EndNote 20 tab), turn instant formatting off
Unformatted Citations

EndNote Library (Desktop) or Shared EndNote Library

2. Add citations; EndNote code will appear. Good option if you prefer not to work with the reference list at the bottom of the document.

There have been several studies that investigated using Wikipedia in the classroom in academics and academic health sciences. Murray’s article investigated using Wikipedia as a platform to teach evidence-based medicine to first-year medical students. For one semester, instructors used Wikipedia as a knowledge tool for students to review entries, search for resources, identify knowledge gaps in the article, and make any necessary edits [Murray, 2020 #231]. Murray, 2020]. At the University of Hawai‘i at Manoa, health sciences librarians used Wikipedia as a resource to promote health literacy by having medical students edit specific health topics’ Wikipedia articles [Kahili-Heede, 2022]. In this article, the authors have found that allowing students to get into these entries and make any necessary changes improved the quality of the information already online and being viewed and the student’s own perceived health literacy [Kahili-Heede, 2022].
Unformatted Citations

Using Microsoft Teams or Word online? Copy/paste from EndNote Desktop

1. In EndNote, right click and select **Copy** (NOT copy formatted reference)
Unformatted Citations

Using Microsoft Teams or Word online? Copy/paste from EndNote Desktop

2. **Paste** the citation where you want it to appear (screenshot is in Teams)
To show formatted citations and reference list.

1. Turn **Instant Formatting On**
2. If you are using Teams or Office online, download the document.
   Recommendation: assign one person to manage the citations from here on out.
Adding citations from Shared Groups

Go to your EndNote Online account
1. Select the Organize tab
2. Click on Others’ Groups
3. Check “Use for Cite While You Write” next to the group you want to use.
Adding citations from Shared Groups

1. In Word (EndNote 20 tab), turn instant formatting off
2. Enter in citations as normal
Using EndNote Online?

Word > EndNote Tab
1. Preferences
2. Application tab
3. EndNote Online
4. Click OK
Using EndNote Groups in Teams and Word Online

Manually enter in unformatted citation: {last name, date}

There have been several studies that investigated using Wikipedia in the classroom in academics and academic health sciences. Murray’s article investigated using Wikipedia as a platform to teach evidence-based medicine to first-year medical students. For one semester, instructors used Wikipedia as a knowledge tool for students to review entries, search for resources, identify knowledge gaps in the article, and make any necessary edits [Murray, 2020]. At the University of Hawaii at Manoa, health sciences librarians used Wikipedia as a resource to promote health literacy by having medical students edit specific health topics’ Wikipedia articles [Kahili-Heede, 2022]. In this article, the authors have found that allowing students to get into these entries and make any necessary changes improved the quality of the information already online and being viewed and the student’s own perceived health literacy [Kahili-Heede, 2022].
Using EndNote Groups in Teams and Word Online

Download Document
• Make sure you are in EndNote Online
• Click Update Citations and Bibliography
  • Formatted citations will appear
Citations in EndNote
<table>
<thead>
<tr>
<th>Author</th>
<th>Year</th>
<th>Title</th>
<th>Reference Type</th>
<th>Date</th>
<th>Edition</th>
<th>Journal</th>
<th>Last Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allahwala, Usai</td>
<td>2013</td>
<td>Wikipedia use amongst medical students-n...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>Medical teacher</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Amin, Wazruhe;</td>
<td>2022</td>
<td>Use and trustworthiness of Wikipedia infor...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>Digital Library Perspectives</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Apollonio, Dorie</td>
<td>2018</td>
<td>Pharmacy students can improve access to q...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>BMC Medical Education</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Ball, Caroline</td>
<td>2019</td>
<td>WikiLiteracy: Enhancing students' digital liter...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>Journal of Information Literacy</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Dowell, Meghan</td>
<td>2019</td>
<td>A perspective on Wikipedia: Your students a...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>The Journal of Academic Librarian...</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Guven, Tolga;</td>
<td>2020</td>
<td>Learning through Osmosis: a global Wikipe...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>MedEdPublish</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Haigh, Carol A.</td>
<td>2011</td>
<td>Wikipedia as an evidence source for nursing...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>Nurse education today</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Kahili-Heede, Mel</td>
<td>2019</td>
<td>Medical Students &amp; Wikipedia Editing: Impl...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>Journal of the Medical Library Ass...</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Kahili-Heede, Mel</td>
<td>2022</td>
<td>Library instruction and Wikipedia: investigati...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>Academic Medicine</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Murray, Heather;</td>
<td>2020</td>
<td>Teaching evidence-based medicine to medic...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>The Internet and Higher Education</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Selwyn, Neil G...</td>
<td>2016</td>
<td>Students’ use of Wikipedia as an academic r...</td>
<td>Journal Article</td>
<td></td>
<td></td>
<td>Web Page</td>
<td>3/15/2023</td>
</tr>
<tr>
<td>Network of the N...</td>
<td>2023</td>
<td>Wikipedia Edit-a-thon: Spring 2023 #CiteNL...</td>
<td>Web Page</td>
<td></td>
<td></td>
<td></td>
<td>3/15/2023</td>
</tr>
</tbody>
</table>
Manually Entering in Citations

Check your citation style format:
1. Right-click the citation
2. Select “Copy formatted reference”

# Update Reference Information

<table>
<thead>
<tr>
<th>Author</th>
<th>Year</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redmond, B.; Jos...</td>
<td>2020</td>
<td>Stress as tool for the management of...</td>
</tr>
<tr>
<td>Reinelt, J.; Uhlig, ...</td>
<td>2019</td>
<td>Acute psychiatric...</td>
</tr>
<tr>
<td>Remotti, H.; Subr...</td>
<td>2012</td>
<td>Small-bowel...</td>
</tr>
<tr>
<td>Rinagel, M.; Chat...</td>
<td>2019</td>
<td>Diagnostic performance of temporal artery...</td>
</tr>
</tbody>
</table>

**Actions:**
- Edit Reference
- Copy References To
- Copy Formatted Reference
- E-mail Reference
- Move References to Trash

**Add References To:**
- Remove References From Group

**Other Actions:**
- Cut
- Copy
- Paste

**Find Full Text**
- Authenticate...
- Find Reference Updates
- OpenURL Link
- Open URL
- Mark as Read
- Rating
- Open in New Tab
Find Reference Updates

The available updates are shown on the left and highlighted in blue. “Update All Fields” copies every updated field from the Available Updates to My Reference, replacing anything already existing in the field(s) in My Reference. “Update Empty Fields” copies available updates only when the corresponding field in My Reference is blank. Text can also be manually copied and pasted into fields.
Editing Citation Styles

Wikipedia use amongst medical students—new insights into the digital revolution

U. K. Allahwala, A. Nadkarni and D. F. Sebaratnam

Medical teacher 2013 Vol. 35 Issue 4 Pages 337-337
Editing Citation Styles
1. Place your cursor where you want the new field to go (ex: Type of Article).
2. EndNote will save a COPY of the citation; it will not replace the original.
3. Search for existing output styles online: https://endnote.com/downloads/styles/
Exporting from EndNote
Export from EndNote (RIS)

Create an RIS file of your EndNote Library
Export from EndNote (RIS)

1. Name your file
2. Save as a Text File
3. Use RefMan RIS Export
4. Export selected references OR export the entire library
Export from EndNote (Excel)
1. Name your file
2. Save as a Text File
3. Use Tab Delimited
4. Export selected references OR export the entire library
Export from EndNote (Excel)
Export from EndNote (Excel)
Export from EndNote (Excel)

<table>
<thead>
<tr>
<th>Column1</th>
<th>Column2</th>
<th>Column3</th>
<th>Column4</th>
<th>Column5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal Article</td>
<td>U. K. Allahwala; A. Nadjm; D. F. Sebaratnam</td>
<td>2013</td>
<td>Wikipedia use amongst medical students—new insights into their use</td>
<td>Medical education and professional development</td>
</tr>
<tr>
<td>Journal Article</td>
<td>W. Amin; M. F. Warraich</td>
<td>2012</td>
<td>Use and trustworthiness of Wikipedia information: students’ perspectives</td>
<td>Digital literacy and education</td>
</tr>
<tr>
<td>Journal Article</td>
<td>D. E. Apolloio; K. Bryde; A. Azzam; M. De Guia; J. Helli...</td>
<td>2018</td>
<td>Pharmacy students can improve access to quality medical information</td>
<td>Pharmacy education and practice</td>
</tr>
<tr>
<td>Journal Article</td>
<td>C. Ball</td>
<td>2019</td>
<td>WikiLiteracy: Enhancing students’ digital literacy with Wikipedia</td>
<td>Journal of Medical Education and Practice</td>
</tr>
<tr>
<td>Journal Article</td>
<td>M. L. Dowell; L. M. Bridges</td>
<td>2019</td>
<td>A perspective on Wikipedia: Your students are here, where are you?</td>
<td>Teaching and Learning in Higher Education</td>
</tr>
<tr>
<td>Journal Article</td>
<td>T. Guven; C. Geraci; J. Green; J. Neist; M. Gopelakrishna...</td>
<td>2020</td>
<td>Learning through Osmosis: a global Wikipedia editing initiative</td>
<td>Learning and Research Magazine</td>
</tr>
<tr>
<td>Journal Article</td>
<td>C. A. Haigh</td>
<td>2011</td>
<td>Wikipedia as an evidence source for nursing and healthcare</td>
<td>Nursing Research and Practice</td>
</tr>
<tr>
<td>Journal Article</td>
<td>M. Kahlil-Heede; E. Hichinuma; R. Katuya</td>
<td>2019</td>
<td>Medical Students &amp; Wikipedia Editing: Implications for...</td>
<td>Medical Sciences and Practice</td>
</tr>
<tr>
<td>Journal Article</td>
<td>M. Kahlil-Heede; U. Patil; K. J. Hillgren; E. Hichinuma;...</td>
<td>2022</td>
<td>Library instruction and Wikipedia: Investigating student...</td>
<td>Library and Information Technology Journal</td>
</tr>
<tr>
<td>Journal Article</td>
<td>H. Murray; M. Walker; J. Dawson; N. Simper; L. A. Mage...</td>
<td>2020</td>
<td>Teaching evidence-based medicine to medical students...</td>
<td>Academic Medicine</td>
</tr>
<tr>
<td>Web Page</td>
<td>Network of the National Library of Medicine</td>
<td>2023</td>
<td>Wikipedia Edit-a-thon: Spring 2023 #CiteNLM Wikipedia...</td>
<td>Knowledge and Information Management Journal</td>
</tr>
<tr>
<td>Journal Article</td>
<td>N. Selwyn; S. Gorard</td>
<td>2016</td>
<td>Students’ use of Wikipedia as an academic resource—P...</td>
<td>The American Journal of Pharmaceutical Education</td>
</tr>
</tbody>
</table>
Resources

• **EndNote Expert features tutorials – Clarivate**

• **EndNote Output Styles:**
  [https://endnote.com/downloads/styles/](https://endnote.com/downloads/styles/)

• **UNMC EndNote Research Guide**
  [https://unmc.libguides.com/endnote](https://unmc.libguides.com/endnote)

• **EndNote Tech Support:**
  [https://support.clarivate.com/Endnote/s/?language=en_US](https://support.clarivate.com/Endnote/s/?language=en_US)